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Abstract 

Cost and time are benchmarks for project success and failure. This is evidenced by the fact that 
the quality of the work is not compromised, and is completed in a short time at minimal cost. 
Therefore, time and cost optimization efforts are very important when planning a project. One 
way to optimize time and costs is the crash method. Crashing is a deliberate, systematic, and 
analytical process through which testing accelerates all activities in a project focusing on 
activities that are on the critical path. In this study, we used the Microsoft Project 2021 program 
to optimize time and costs. By entering survey data into the program, this Microsoft Project will 
automatically perform calculations, resulting in more accurate calculations., Faster and More 
Accurate Findings from the Pamrang Cluster Housing Project show that the accelerated 
implementation has resulted in a reduction in indirect and overall project costs. From the 
calculation results, the optimal project completion time is 115.96 working days (144 calendar 
days) and the total project cost is IDR 361,005,732.00. While the normal completion time is 
136.08 working days (68 calendar days) and the total project cost is IDR 364,091,924.-. This 
will reduce runtime for 24 days and reduce costs by IDR 3,086,192.00. 

Keywords: Cost Optimization and Construction Time, Microsoft Project 2021, Crash Method 
 

Abstrak 
Biaya dan waktu adalah tolok ukur keberhasilan dan kegagalan  proyek. Hal ini 
dibuktikan dengan fakta bahwa kualitas pekerjaan tidak terganggu, dan diselesaikan 
dalam waktu  singkat dengan biaya minimal. Oleh karena itu, upaya optimasi waktu 
dan biaya sangat penting ketika merencanakan suatu proyek. Salah satu cara  untuk 
mengoptimalkan waktu dan biaya adalah metode crash. Crashing adalah  proses 
yang disengaja, sistematis, dan analitis melalui pengujian dengan mempercepat 
semua aktivitas dalam sebuah proyek yang fokus pada aktivitas yang berada di jalur 
kritis. Dalam penelitian ini, kami menggunakan program Microsoft Project 2021 untuk 
mengoptimalkan waktu dan biaya. Dengan memasukkan data survei ke dalam 
program,  Microsoft Project ini akan  secara otomatis melakukan perhitungan, 
sehingga perhitungan  lebih akurat., Lebih Cepat dan Lebih Akurat Temuan dari 
Proyek Perumahan Cluster Pamrang menunjukkan bahwa percepatan yang 
diterapkan menyebabkan pengurangan biaya proyek tidak langsung dan 
keseluruhan. Dari hasil perhitungan diperoleh waktu penyelesaian proyek yang 
optimal adalah 115,96 hari kerja (144 hari kalender) dan total biaya  proyek sebesar 
Rp361.005.732,00. Sedangkan waktu penyelesaian normal adalah 136,08 hari kerja 
(68 hari kalender) dan total biaya  proyek adalah Rp.364.091.924,-. Hal ini akan 
mengurangi runtime selama 24 hari dan mengurangi biaya sebesar Rp 3.086.192,00. 

Kata Kunci : Optimasi Biaya dan Waktu Konstruksi, Microsoft Project 2021, Metode Crash 
 
PENDAHULUAN 

Pemberlakuan pembatasan kegiatan masyarakat yang mulai sejak awal maret 2020 akibat 

pandemi yang telah terjadi di Indonesia membuat sejumlah proyek di dunia konstruksi terhambat. Hal 

ini mengakibatkan produsen bahan bangunan & pabrik-pabrik mengurangi kegiatan operasional. 

Sedangkan masuknya konstruksi sebagai pekerjaan esensial membuat permintaan akan produk 
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bahan bangunan tetap harus berjalan, inilah alasan utama dari naiknya harga bahan bangunan / 

inflasi. 

Ketika datang ke implementasi, keberhasilan atau kegagalan sering disebabkan oleh kegiatan 

proyek yang tidak direncanakan serta kontrol yang tidak efektif. Hal ini akan mengakibatkan 

keterlambatan, penurunan kualitas pekerjaan, dan peningkatan biaya pelaksanaan, yang 

kesemuanya merupakan akibat dari kegiatan proyek yang tidak efisien. Kondisi yang sangat tidak 

menguntungkan adalah kondisi dimana terjadi keterlambatan penyelesaian proyek secara 

keseluruhan. Dampak langsung dari pandemi Covid-19 telah menyebabkan kenaikan harga berbagai 

komoditas, termasuk harga sejumlah barang bahan bangunan, seperti semen, besi, beton, dan paku. 

Ini terkait dengan fakta bahwa harga ini telah meningkat secara signifikan. 

Menurut situs Sistem Pengawasan Pasar dan Kebutuhan Pokok yang dijalankan Kementerian 

Perdagangan (Kemendag), biaya pembelian 50 kilogram semen meningkat selama minggu keempat 

Desember 2021 jika dibandingkan dengan biaya selama minggu sebelumnya (Laucereno, 2021) . 

Kira-kira naik 2%. Bahkan, harga Semen Tonasa 50 kg naik 16,60%. 

Selain itu, biaya baja dan beton naik 1% menjadi 2%, yang diikuti oleh kenaikan biaya paku 

2 cm sebesar 5,60%. Menurut tradingeconomics.com, mulai pertengahan Desember 2021, ada tren 

kenaikan umum harga aluminium di pasar internasional. Atau, kira-kira dua bulan setelah mencapai 

level tertinggi pada 15 Oktober 2021, yaitu sekitar dua tahun dari sekarang. Badan Pusat Statistik 

(BPS) mencatat Indeks Harga Perdagangan Besar (IHPB) untuk kelompok bangunan/bangunan pada 

September 2021. Indeks ini menunjukkan adanya kenaikan sebesar 0,29%, atau mengalami 

perubahan indeks, dari 107,66 pada Agustus 2021. menjadi 107,97 pada bulan September 2021. 

Kelompok bangunan/bangunan terdiri dari lima kelompok jenis bangunan. Menurut informasi yang 

diberikan oleh Kepala BPS Margo Yuwono (IHPB, 2021, halaman 179), perubahan IHPB Kelompok 

Bangunan/Bangunan selama tahun kalender 2021 adalah 4,14%, dan perubahan IHPB Kelompok 

Bangunan/Bangunan meningkat 4,73 poin persentase dari satu tahun ke tahun berikutnya. 

Harga perlengkapan konstruksi naik lebih dari 5-10%, mencerminkan kenyataan bahwa, di 

lapangan, harga meningkat secara signifikan. Padahal, jika berbicara tentang ekonomi, adalah hal 

yang wajar untuk mengatakan bahwa jika ada kelangkaan barang, harga akan meroket. Namun, 

penting untuk dicatat bahwa dalam situasi sulit seperti ini, di mana orang diharuskan bekerja dari 

rumah, ada juga orang yang diberhentikan dari pekerjaannya, yang berarti keadaan ini sangat sulit 

bagi perekonomian di Indonesia. Komunitas. 

Karena harga bahan bangunan melonjak naik akibatnya makin marak saja proyek yang 

terhambat dan bahkan terlantar. Masih lebih banyak lagi penyebab keterlambatan pelaksanaan 

pekerjaan konstruksi. Perihal tersebut menuntut perencana untuk membuat penjadwalan proyek yang 

efisien & efektif supaya meminimalisir kerugian dan membuat proyek konstruksi berjalan normal 

sampai sukses. Perencanaan proyek yang baik merupakan pondasi dari suksesnya pembangunan 

konstruksi dan merupakan pedoman kepada pelaksana yang terlibat di dalam proyek. Segala resiko 

dan hambatan sudah di perhitungkan didalam perencanaan. 

Ketika datang ke implementasi, alasan keberhasilan atau kegagalan sering ditelusuri kembali 

ke kegiatan proyek yang tidak direncanakan selain kontrol yang tidak efisien. Hal ini akan 

mengakibatkan keterlambatan, penurunan kualitas pekerjaan, dan peningkatan biaya pelaksanaan, 

yang kesemuanya merupakan akibat dari kegiatan proyek yang tidak efisien. Kegiatan proyek yang 
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tidak efisien akan menyebabkan hasil ini. Situasi di mana ada keterlambatan dalam penyelesaian 

keseluruhan proyek adalah salah satu yang dianggap sangat tidak menguntungkan. Dampak 

langsung dari pandemi Covid-19 telah menyebabkan kenaikan harga berbagai komoditas, termasuk 

harga sejumlah barang bahan bangunan, seperti semen, besi, beton, dan paku. Hal ini karena 

pandemi telah menyebabkan peningkatan permintaan barang-barang tersebut sebagai akibat 

langsung dari peningkatan permintaan yang disebabkan oleh pandemi. Hal ini terkait dengan fakta 

bahwa harga ini telah meningkat secara signifikan selama beberapa tahun terakhir. 

Menurut situs Sistem Pengawasan Pasar dan Kebutuhan Pokok yang dioperasikan 

Kementerian Perdagangan (Kemendag), biaya pembelian 50 kilogram semen meningkat selama 

minggu keempat Desember 2021 jika dibandingkan dengan biaya selama seminggu sebelumnya. 

untuk itu (Laucereno, 2021). Kira-kira setara dengan kenaikan 2%. Bahkan, terjadi kenaikan biaya 

pembelian Semen Tonasa 50 kg sebesar 16,60%. 

Selain itu, harga baja dan beton naik satu hingga dua persen, yang diikuti dengan kenaikan 

harga paku dua sentimeter sebesar lima setengah persen. Menurut tradingeconomics.com, tren 

kenaikan harga aluminium secara umum di pasar internasional dimulai sekitar pertengahan Desember 

2021. Tren ini berlanjut hingga akhir Desember 2021. Atau, sekitar dua bulan setelah mencapai 

puncaknya pada 15 Oktober, 2021, yang akan menjadi sekitar dua tahun dari sekarang. Pada 

September 2021, Indeks Harga Perdagangan Besar (IHPB) tercatat oleh Badan Pusat Statistik (BPS). 

Indeks ini berkaitan dengan kelompok bangunan dan konstruksi. Indeks ini mengungkapkan bahwa 

terjadi kenaikan sebesar 0,29%, atau perubahan indeks, dari 107,66 pada Agustus 2021 menjadi 

107,97 pada September 2021, bergerak dari nilai sebelumnya 107,66. Ada lima kelompok berbeda 

dari jenis bangunan yang membentuk kelompok bangunan dan konstruksi. Menurut data yang 

disampaikan Kepala BPS Margo Yuwono (IHPB, 2021, halaman 179), perubahan IHPB Kelompok 

Bangunan/Bangunan selama tahun kalender 2021 sebesar 4,14%. Selanjutnya, perubahan IHPB 

untuk Kelompok Bangunan/Bangunan meningkat 4,73 poin persentase dari satu tahun ke tahun 

berikutnya. 

Kenyataan bahwa harga di lapangan telah meningkat dalam jumlah yang signifikan tercermin 

dalam fakta bahwa harga pasokan konstruksi telah meningkat lebih dari 5-10%. Padahal, jika 

berbicara tentang ekonomi, adalah hal yang wajar untuk mengatakan bahwa jika ada kelangkaan 

barang, harga akan meroket. Ini adalah sesuatu yang telah terbukti berkali-kali. Namun, penting untuk 

diingat bahwa dalam keadaan sulit seperti ini, di mana orang diharuskan bekerja dari rumah, ada juga 

orang yang harus diberhentikan dari pekerjaannya, yang menunjukkan bahwa keadaan ini sangat 

menantang bagi perekonomian masyarakat secara keseluruhan. 

 
BAHAN & METODOLOGI PENELITIAN 

Nama Perumahan yang menjadi studi kasus ini yaitu Vinus 88 Residence dengan alamat di 

Jl. Pinang Raya, Pamulang Timur, Tangerang Selatan yang mana Developernya PT Multi Sarana 

Satria dengan jumlah rumah sebanyak 156 unit. Pengumpulan data dilakukan untuk memaksimalkan 

efisiensi. Penyedia layanan, konsultan pengawas, dan lainnya harus memberikan informasi sekunder 

sedangkan waktu dan uang adalah kuncinya. Variabel waktu terdiri data cumulative progress yang 

berupa jenis kegiatan, persentase kegiatan, dan durasi kegiatan. Proses pengumpulan data dilakukan 

dengan cara mendatangi langsung lokasi proyek dan minta ke bagian kontraktor. Variabel biaya 
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memerlukan daftar anggaran biaya penawaran yang terdiri dari jumlah biaya normal dan durasi 

normal. Pengolahan data akan dilakukan dengan bantuan program Microsoft Project 2021. Menyusun 

jaringan kerja tahapannya terdiri dari a) membuat lembar kerja baru dan membukanya, b) tentukan 

tanggal mulai proyek, c) Menginput data terkait kegiatan proyek, d) Membangun link dan hubungan 

antara berbagai pekerjaan, e) buat kalender kerja untuk merencanakan hari dan jam kerja, f) 

masukkan biaya yang terkait dengan setiap pekerjaan, dan g) gunakan jadwal dan anggaran yang 

direncanakan sebagai dasar untuk pekerjaan. Pelaksanaan penelitian dibagi menjadi beberapa 

tahapan diantaranya yaitu tahap 1 (mulai), tahap 2 (masalah), tahap 3 (persiapan), tahap 4 

(penentuan objek penelitian), tahap 5 (pengumpulan data), tahap 6 (analisis dan pembahasan), tahap 

7 (kesimpulan & saran), dan tahap 8 (selesai). 

 

ANALISIS & PEMBAHASAN 

Analisis Data 

Proyek yang ditinjau dalam penelitian ini adalah Proyek Rumah di Pamulang dengan : 

Nilai Konstrak : Rp. 370.000.000,- 

Waktu pelaksanaan : 130 hari kerja 

Tanggal pekerjaan mulai : 01 April 2022 

Tanggal pekerjaan selesai : 

Bab ini juga akan memberikan gambaran rinci tentang optimalisasi biaya dan waktu proyek 

menggunakan metode crash dengan bantuan aplikasi yang dikenal dengan nama Microsoft Project 

Professional 2021. Proses analisis data dilakukan dengan cara langsung menginput data ke dalam 

program yang diketahui sebagai Microsoft Project Professional 2021. Program ini terdiri dari dua 

tahap, yaitu sebagai berikut: 

(1) Menyusun rencana jadwal dan biaya proyek. 

(2) Optimasi dengan actual overtime work. 

 
Menyusun Rencana Jadwal dan Biaya Proyek 

Beberapa hal penting dalam setting Microsoft Project : 
- Pengaturan waktu mulai proyek 

- Pengaturan kalender 

- Pengaturan mode autoschedule 

- Pengaturan mata uang Rupiah 

- Penentuan Jalur Kritis 

- Free Slack & Total Slack 

 
Memulai Aplikasi Microsoft Project. 

1. Membuka lembar kerja baru. 

2. Klik tombol Start > Program > Microsoft Office > Microsoft Office Project 2021. 

3. Memasukan tanggal dimulainya proyek. 

4. Mengaktifkan menu Projet Information. Pada kotak dialog Project Information dipilih Schedule 

From: Project Start Date dan memasukan tanggal dimulainya proyek yaitu 01 April 2022 pada 

kotak Start Date.  
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5. Menyusun kalender kerja merencanakan hari kerja dan jam kerja. 

Sebelum menginput data sebaiknya lakukan pengaturan waktu kerja (Change Working Time) 

pada project information. Pada menu Schedule Minggu diawali pada hari senin, waktu mulai 

kerja pada jam 8 pagi sampai jam 5 sore, maka menjadi 8 jam karena 1 jam untuk istirahat, 

dalam seminggu jadi 8 x 5 = 40 jam, ditambah hari sabtu masuk setengah hari yaitu dari jam 

8 pagi sampai dengan jam 1 siang. maka total jam kerja seminggu adalah 40 jam. Selanjutnya 

hari kerja per-bulan menjadi total 20 hari dengan kerja dihitung per-jam dan  mata uang yang 

digunakan untuk pembayaran yaitu rupiah (IDR). Disini juga diisi tanggal-tanggal merah (libur) 

yang dapat dilihat pada gambar berikut. 

6. Mengisi Kegiatan-Kegiatan Proyek. 

Tahap ini kita menginput kegiatan pada proyek juga sembari menyusun lingkup pekerjaan 

(indentation). Memasukan data kegiatan proyek dengan mengetikannya pada kolom Task 

Name dan waktu kegiatan pada kolom Durasi. Setelah kolom durasi diisi, kolom Start dan 

Finish akan terisi secara otomatis. 

Pada Analisa Harga Satuan Pekerjaan Standar Nasional Indonesia (AHSP SNI) kita dapat 
menghitung durasi pekerjaan dengan menggunakan indeks upah dengan menggunakan 
rumus. Rumus untuk menghitung durasi pekerjaan yaitu : 

V∗OH

D
= Pax  

Rumus 1. Durasi Pekerjaan 

V = Volume pekerjaan 

OH = Indeks upah 

D = Durasi pekerjaan 

Pax = Jumlah pekerjaan 

7. Menyusun Diagram Logika Jaringan Kerja. 

Hubungan antara pekerjaan satu dengan lainnya di masukan didalam kolom Predecessors. 

Memerhatikan hubungan antar aktivitas dan logika hubungan yang terjadi diantara kegiatan 

yaitu mendahului (Predessor), mengikuti (Successor), dan bersamaan (Concurent). Contoh 

Pengisian : Pekerjaan urukan pasir (pada baris 5) dimulai setelah pekerjaan galian tanah 

(pada baris 2) selesai dikerjakan (Finish to Start). Maka pada kolom predecessor pekerjaan 

urukan pasir diisi 4FS. 

8. Memasukan Sumber Daya. 

Kita dapat menginput sumber daya pada menu View > Resource Sheet. Setelah itu gunakan 

menu show split untuk mengedit sumber daya pada jaringan kerja. 

9. Memasukan biaya untuk tiap pekerjaan. 

Untuk memasukan total biaya proyek, maka dilakukan langkah: Klik menu View > Table > 

Cost. Biaya yang dimasukan isini merupakan biaya yang sudah ditetapkan sebelumnya 

dalam Rencana Anggaran Biaya (RAB). Biaya ini kemudia dimasukan ke dalam kolom Fixed 

Cost, sehingga nilai Total Cost sama dengan Fixed Cost. Hasil input biaya proyek dapat 

dilihat pada Gambar dibawah ini. 

10. Memasukan besar biaya tidak langsung (Indirect Cost). 

Di dalam RAB Proyek Perumahan Pamulang ini tidak terdapat keterangan biaya tidak 

langsung karena sudah termasuk didalam biaya langsung (direct Cost). 
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11. Membuat skejul rencana (Baseline). 

Menu Project > Set Baseline. Untuk membuat baseline tetap tampil di Gantt chart dapat 

membuat custom gantt chart menggunakan Gantt Chart Wizard.  

 

Optimalisasi 

Otimalisasi dilakukan dengan mengisikan data yang tlah di optimalkan untuk dibandingkan 

dengan rencana awal. Langkah-langkah yang dilakukan antara lain : 

1. Membagi layar Microsoft Project menjadi dua (atas & bawah) untuk memasukan data crash 

perencanaan. Layar atas adalah Gantt chart view sedangkan bawah yaitu Task Usage, lalu 

klik View > Table ; Cost. 

2. Menambahkan baris pada bagian kaan Task Usage dengan menekan mouse kanan, pilih 

Detail Styles. Membuka tampilan Actual Work, Actual Overtime Work, Actual Cost. 

3. Melmasukan durasi lembur dengan Tracking pada baris Actual Overtime Work yaitu dengan 

klik Task > Task Information > General > Percent complete “100%” > Duration (diisi dengan 

rencana crash) > Ok. 

4. Memasukan jam lembur resources work pada baris actual overtime work 

 
Dengan cara : 

Pekerjaan Dinding pada task 5.1 yaitu Pekerjaan pasang bata ringan (Hebel/celcon) dalam 

baseline durasi pekerjaanya yaitu 556,48 jam yang berarti pekerjaan dikerjakan dalam 69,56 hari. 

Pada baris Actual Overtime Work dengan memasukan jumlah kerja lembur per-jam,maka 

Microsoft Project akan menghitung secara otomatis dalam hari. 

Pekerjaan Dinding – Pasang bata ringan (hebel/celcon) : 

Data diketahui : 

Nd     = 69,56 hari / 70 hari 
Cd     = 60 hari 
Volume    = 231,85 m² 
Pekerja    = 4 orang, Koef pekerja = 0,2 
Mandor    = 1 orang. Koef mandor = 0,05 

Produktivitas Normal (Fn)  = 
𝑃𝑒𝑘𝑒𝑟𝑗𝑎

𝐾𝑜𝑒𝑓 𝑃𝑒𝑘𝑒𝑟𝑗𝑎
 = 

4

0,2
 = 20 m³ / hari 

Produktivitas (F)   = 
𝐹𝑛

8
 = 30 m² / hari = 1,25 m² / jam 

Produktivitas Crash (Fc)  = 0,91 x F = 0,91 x 1,25 = 1,1375 / 1,14 m² / jam 

Durasi Crash (Dc)   = 
𝑉𝑜𝑙𝑢𝑚𝑒 𝑝𝑒𝑘𝑒𝑟𝑗𝑎𝑎𝑛

𝐹𝑐
 = 

231,85

1,14
 = 203,37 

Lembur    = 20 jam 
Harga total pekerjaan  = Rp 36.289.162,00 
 
Jam lembur hanya diaplikasikan untuk sumber daya manusia (Pekerja, tukang & mandor). Perlu 

diketahui setelah disahkan-nya UU Cipta Kerja, perhitungan lembur adalah maksimal 4 jam / hari 

dan 18 jam / minggu. Langkah menginput jam lembur pada Microsoft Project antaralain : 

Kolom Actual Overtime di isikan jumlah jam lembur yaitu 4 jam dengan begitu jumlah kerja jadi 8 
+ 3 = 11 jam. 

Contoh : Lembur pekerjaan pasangan bata 
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Jam lembur / hari = 
20 𝑗𝑎𝑚

5
 = 4 jam 

Jumlah jam lembur per-hari = 4 jam x 4 pekerja = 16 jam (berlaku untuk sumber daya manusia 
lain dan secara otomatis Microsoft Project akan menghitung dalam bentuk days) 
Kolom Actual Cost terisi jumlah biaya yang otomatis terhitung jika kolom Actual Work dan Actual 

Overtime telah diisi. 
Kolom Work terisi jumlah dari Actual Work dan Actual Overtime. 
 
Percepatan proyek 

Percepatan bisa di lakukan dengan berbagai metode, antara lain menambah pekerja terampil, 

pekerjaan lembur, mengatur ulang jadwal yang terlambat juga bisa saling tukar tenaga kerja 

terampil. Namun, pada penelitian ini hanya akan dilakukan percepatan dengan metode 

penambahan jam kerja (lembur). 

Berdasarkan diagram Gantt pada software Microsoft Project Lintasan kritis dapat dilihat dengan 
mudah. Pada penelitian ini akan dilakukan crash sebanyak 3x sampai pekerjaan jenuh. 
Pekerjaan yang dilakukan oleh sub-kontraktor tidak akan dilakukan percepatan. 
 
Tahap-Tahap Percepatan 

Uraian tahap-tahap percepatan dapat dilihat di dalam sub-bab berikut ini : 

1. Penentuan durasi tipikal berdasarkan jaringan  dan biaya proyek tipikal. 

2. Tentukan jalur kritis untuk durasi proyek normal. 

3. Tabel semua biaya untuk periode normal dan dipercepat dan semua aktivitas. 

4. Hitung dan tabulasi kenaikan biaya untuk setiap aktivitas. 

5. Mempersingkat durasi aktivitas kritis, dimulai dengan aktivitas kritis dengan kombinasi nilai 

kenaikan biaya terendah. 

6. Setiap aktivitas kritis  dipercepat sampai waktu percepatan yang diinginkan tercapai atau 

jalur kritis baru terbentuk. Setelah membentuk jalur kritis baru, mempersingkat waktu 

aktivitas kritis sehingga nilai kenaikan biaya minimal. Jika ada beberapa jalur kritis, aktivitas 

di jalur kritis harus dikurangi pada saat yang sama jika  durasi proyek secara keseluruhan 

akan dipersingkat. 

7. Pada setiap langkah, periksa apakah setiap aktivitas memiliki masa tenggang atau buffer. 

Jika demikian, kegiatan  dapat ditunda untuk mengurangi biaya proyek. 

8. Pada setiap siklus percepatan, biaya proyek dihitung dari durasi proyek  baru, ditabulasi, 

dan diplot pada grafik biaya proyek versus waktu. 

9. Lanjutkan sampai Anda tidak bisa lagi berakselerasi. Ini disebut  titik percepatan. 

10. Plot overhead proyek pada grafik biaya versus waktu yang sama. 

11. Jumlahkan biaya langsung dan  tidak langsung dari total biaya proyek untuk  setiap periode. 

12. Gunakan kurva total biaya  proyek  untuk menentukan waktu terbaik untuk menyelesaikan 

dengan biaya terendah atau  proyek sesuai dengan jadwal yang Anda inginkan. 

 
Hampir setiap proyek pada suatu saat akan dihadapkan pada situasi kritis dimana kinerja 

proyek tidak dapat dicapai dalam batasan waktu dan biaya yang direncanakan. Ada 

kemungkinan tidak perlu ada kompromi jika semuanya berjalan sesuai rencana dengan proyek. 

Proses mencapai kompromi berlanjut sepanjang siklus hidup proyek dan terus dipengaruhi oleh 
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lingkungan internal dan eksternal, serta reputasi perusahaan, kondisi pasar, dan tingkat 

keuntungan yang diantisipasi. Untuk tujuan melakukan penelitian tambahan tentang korelasi 

antara waktu aktivitas dan biaya. 

 
Kondisi Normal 

Pada kondisi normal waktu pelaksanaan proyek adalah 136 hari dan terdapat beberapa jalur 

kritis yang terlihat di dalam diagram Gantt Microsoft Project. Lintasan kritis yang ditunjukan di dalam 

diagram Gantt merupakan Task di Outline Number nomor 5, 6 & 10 yaitu pekerjaan dinding, pekerjaan 

plesteran / acian, dan pekerjaan penutup atap. 

 
Tabel 1. Penambahan jam lembur dari kondisi normal 

Outline 
Number 

Uraian Pekerjaan 
Durasi 

Normal Crash 

5.1 Pasang bata ringan (hebel/celcon) 69,56 49,56 

6.1 Plesteran campuran 1 pc : 3 psr tebal 1,5 cm 87,39 77,39 

10.1 Pasang atap genting beton 15,09 12,09 

10.2 Pasang nok genting beton 2,4 1,4 

10.3 Pasang rangka atap baja ringan (pabrikan) 11,32 8,32 

 
Contoh perhitungan biaya akibat chrashing pada penambahan jam kerja. 
Pekerjaan dinding (Outline 5.1) 
Nd  = 69,56 hari 
Volume = 231,85 m² 
SDM   =  Pekerja (P1)  :556,48 jam.  1 Koef. Pekerja :0,75 

      Tukang batu terampil (Tb1) :370,96 jam 1 Koef. Tukang :0,025 
Biaya kerja (Data sesuai proyek) 

Pekerja (P2)   = Rp 150.000 / hari = Rp 18.750 / jam 
Tukang batu terampil (Tb1) = Rp 206.000 / hari = Rp 25.750 / jam 

Harga Total  = Rp 36.289.162 (Lihat RAB) 
Harga material  = Rp 0   (Lihat AHSP) 
Harga Non-material = H. Total – H. Material 
   = Rp 36.289.162 – Rp 0 
   = Rp 36.289.162 
Biaya lembur kerja (data sesuai analisa harga satuan standar nasional Indonesia). 

Pekerja    = Rp 30.000 / jam (1,5 x harga normal) 
Tukang batu terampil  = Rp 40.000 / jam (1,5 x harga normal) 
Harga Total   = Rp 70.000 / jam 

Produktivitas Normal (Fn) = 
𝑃𝑒𝑘𝑒𝑟𝑗𝑎

𝐾𝑜𝑒𝑓 𝑃𝑒𝑘𝑒𝑟𝑗𝑎
 = 

4

3
 = 1,33 m³ / hari 

Produktivitas (F)   = 
𝐹𝑛

8
 = 

1,33

8
 = 0,166 m² / jam 

Produktivitas Crash (Fc)  = 0,91 x F = 0,91 x 0,166 = 0,151 m² / jam 

Durasi Crash (Dc)  = 
𝑉𝑜𝑙𝑢𝑚𝑒 𝑃𝑒𝑘𝑒𝑟𝑗𝑎𝑎𝑛

𝐹𝑐
=

1,5

0,151
 = 9,93 / 10 jam 

Dc  = 10, berarti pekerjaan boleh dikerjakan 8 jam (sehari) dengan tambahan kerja 
lembur 2 jam.  
Cd = 20 hari 
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Lembur (L) = Dc – (Cd x 8 jam) = 10 jam – (20 x 8 jam) = 2 jam 
Harga Non-material crash 
= (Cd * P1 * jumlah pekerja) + (Cd * T1 * Jumlah tukang) + (L * P2 * jumlah tukang) + (L * 
T2 * jumlah tukang) 
= (20 * 18.750 * 4) + (20 * 25.750 * 1) + (2 * 30.000 * 4) + (2 * 40.000 * 1) 
= 1.500.000 + 515.000 + 240.000 + 80.000 
= Rp 2.335.000 

Harga total crash = Harga Non-material Crash + Harga Material 
   = Rp 2.335.000 – Rp 0 
   = Rp 2.335.000 

 

Slope  = 
(𝐻𝑎𝑟𝑔𝑎 𝑁𝑜𝑛𝑚𝑎𝑡𝑒𝑟𝑖𝑎𝑙 𝑐𝑟𝑎𝑠ℎ−𝐻𝑎𝑟𝑔𝑎 𝑁𝑜𝑛𝑚𝑎𝑡𝑒𝑟𝑖𝑎𝑙)

(𝑁𝑑−𝐶𝑑)
 

   = 
(𝑅𝑝 36.289.162−𝑅𝑝 2.335.000)

(20−10)
 

   = Rp 3.395.416,20 
Contoh perhitungan perubahan biaya akibat crashing pada penambahan tenaga kerja : 
Pekerjaan Dinding – Pasang bata ringan (hebel/celcon) Task 5.1 

 
Gambar 1 Sumber daya pekerjaan dinding 

 
Nd = 69,56 hari 
Volume = 231,85 m² 
Kebutuhan rencana :  
Pekerja    = 4 orang 
Tukang batu terampil = 1 orang 
Harga Total  = Rp 36.289.162 
Harga Material  = Rp 16.303.843 
Harga non-material = Harga total – Harga material 
   = Rp 36.289.162 – Rp 16.303.843 = Rp 19.985.319 
Direncanakan CD = 20 hari 
Kebutuhan crash : 
 Pekerja = 4 orang x Rp 150.000 x 20 hari = Rp 12.000.000 
 Tukang = 1 orang x Rp 206.000 x 20 hari = Rp 4.120.000 
Harga non-material crash    = Rp 16.120.000 
Harga total crash = Harga non-material crash + Harga material 
   = Rp 16.120.000 + 16.303.843 
   = Rp 32.423.843 

Slope  = 
(𝐻𝑎𝑟𝑔𝑎 𝑛𝑜𝑛𝑚𝑎𝑡𝑒𝑟𝑖𝑎𝑙 𝑐𝑎𝑠ℎ−𝐻𝑎𝑟𝑔𝑎 𝑛𝑜𝑛𝑚𝑎𝑡𝑒𝑟𝑖𝑎𝑙)

(𝑁𝑑−𝐶𝑑)
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  = 
(𝑅𝑝 32.423.843−𝑅𝑝 19.985.319)

(69,56−20)
 

  = Rp 250.979,09 
Keseluruhan perubahan biaya akibat crashing dapat dilihat pada tabel berikut : 

Tabel 2 Perhitungan crashing 1 metode lembur 

 
Catatan : Besaran slope yang ditulis merah berarti bernilai positif atau mendapatkan keuntungan 
dari perlakuan crashing, hal ini dimungkinkan terjadi akibat perencanaan awal proyek 
produktivitas tenaga kerja di baseline kurang maksimal. 

 
Tahap-tahap percepatan 

Kompresi disini maksudnya adalah saat kita melakukan tahap percepatan dengan cara 

memendekan waktu pada pekerjaan yang dihasilkan dari tahap sebelumnya. Perhitungan kebutuhan 

percepatan pada kondisi normal yang diinputkan pada Micosoft Project menyebabkan timbulnya 

lintasan kritis baru dengan pengurangan waktu pelaksanaan proyek dari 136 hari kerja menjadi 116 

hari kerja. Percepatan pada tahap ini menyebabkan kebutuhan biaya proyek menurun hingga 

mencapai Rp. 3.086.192 dari biaya rencana sebesar Rp. 364.091.924. 

 

 
Gambar 2 Baseline Awal 
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Gambar 3 Setelah dilakukan optimalisasi 

  
Setelah dilakukan percepatan didapatkanlah hasil sebagai berikut. 

Durasi pekerjaan proyek berkurang sebesar : 136,08 – 115,96  = 20,12 hari kerja 

Biaya proyek berkurang sebesar 364.091.924 – 361.005.732 = 3.086.192. Opsi sementara 

untuk melakukan optimasi biasanya akan dilakukan crash yaitu dengan cara menambah jam 

kerja. Objek penelitiannya adalah Pembantu Tukang Terampil (Pekerja) yang dibayar Rp 

150.000 /hari, dengan biaya lembur sebesar Rp 30.000 /jam. Jadi pekerja bekerja lembur 4 

jam per-hari dibayar 4 x Rp 30.000 = Rp 120.000. 

Opsi saran saya yaitu dengan cara menambah pekerja di rasa lebih optimal secara waktu & 

biaya dibandingkan melakukan lembur yaitu hanya dengan menambah 1 orang pekerja hanya 

menambah Rp 30.000 dari biaya lembur sudah dapat 8 jam kerja. Kalau dibandingkan: 

Rp 120.000 = 4 jam / orang (Biaya lembur per-orang) 

Rp 150.000 = 8 jam/ orasng (Biaya tambah pekerja) 

Jika semua pekerja (10 orang) melakukan lembur  dalam satu hari : 

Rp 1.200.000 = 40 jam /hari 

Jika menambah pekerja dengan biaya yang sama : 

Rp 1.200.000 / 150.000 = 8 orang = 64 jam. Masih ada surplus durasi tersisa 24 jam kerja. 

Dengan kata lain, dapat menghemat 37,5%. 

 
KESIMPULAN 

a. Penelitian ini telah berhasil membuat jaringan kerja efisien & efektif dengan cara 

menjadwalkan ulang menggunakan Microsoft Project. Dengan mengatur penggunaan 

sumber daya yang baik dan seimbang. 

b. Dengan mengetahui critical path pada jaringan kerja yang telah dibuat untuk 

selanjutnya di lakukan analisa optimasi menggunakan metode crash. Menerapkan 

kerja lembur bagi pekrerja, tukang terampil & helper. 

c. Menemukan biaya dan durasi terbaik yang dapat di aplikasikan pada proyek dari hasil 

penjadwalan ulang menggunakan Microsoft Project. Durasi pekerjaan proyek 
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berkurang sebesar 20,12 hari kerja & biaya proyek dipangkas sebesar 364.091.924 – 

361.005.732 = 3.086.192. 
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